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Revision Tracking Sheet 

This manual may be revised periodically to incorporate new or updated information. 

Note: 

Every effort has been made to keep the information up to date there may be changes to 

the broadcaster’s API if in doubt contact your support department. 

Listed below is the revision date of each page (if applicable): 

PageRevision 

All Pages Updated D054T3X002 - June 2018 

Acoustic acquired IBM Watson in April 2019 – This integration guide is being updated to 

reflect any changes brought about by that purchase, please contact your partner or 

Apteco for information about this integration. 
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1 Introduction 

This integration guide details the processes required to integrate the Apteco Marketing 

Suite with the IBM Watson, SilverPop SilverPop email service provider (ESP). 

Integration options: 

FastStats 
For a one-off broadcast, you can use a combination of the Email Broadcasting and Email 

Responses wizards to upload your list, schedule a broadcast campaign, and finally 

receive responses from your customers back into your FastStats system for further 

analysis. 

PeopleStage 
Automate data uploads for unattended and scheduled marketing broadcasts, 

PeopleStage will allow you to define and implement marketing process flow diagrams 

that will react to the responses you receive from the ESP. 

Export and Upload a File 
Access generic FTP support to allow data export and upload to third-party digital 

broadcast providers. 

Note: 

Apteco approves this integration with SilverPop.  Use of the Apteco Marketing Suite in 

combination with SilverPop software through this integration will not affect the 

intellectual property rights indemnity provided in the Apteco Marketing Suite “End 

User Licence Agreement”. 

 Summary of SilverPop functionality 
Technology 
SilverPop integrates with your FastStats system by utilising a RESTful transport over 

HTTP/S, in conjunction with SFTP. 

Supported Integrations 
SilverPop supports all the above integration options. 

Type of Integration – User Defined 
SilverPop is a User Defined integration meaning you can select variables at run time and 

create a personalised output based on specific requirements. 
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 Before You Begin 
CAUTION 

This guide assumes you have the relevant Apteco Marketing Suite system 

administration experience to perform this task, particularly with the FastStats 

Administrator, SQL Server and the areas of the Apteco Marketing Suite that relate to 

creating selections and campaign creation. If you do not, contact your Apteco partner 

or the Apteco support team. You need to have the appropriate system and SQL Server 

administrator permissions to install the relevant components successfully. Additionally, 

you will need to have Access to the broadcaster web-based control panel and obtain 

all the relevant information from SilverPop. You will also need to understand how to 

construct your message in SilverPop. 

This guide details the steps required to integrate FastStats and PeopleStage with a 

Broadcaster using an API; the document is in two parts: 

1.  The configuration of the Apteco Marketing Suite 

2.  Appendices which include: 

a. A summary of configuration in SilverPop 

b. API Parameters 

You need to configure SilverPop before you perform the steps in Chapter 4 

Useful to have before you start: 

• Database Connection String made up of the database server Instance name 

and FastStats system name, for example: 

<SQLServerInstanceName>;Initial Catalog=RS_<SystemName>;User 
Id=faststats_service;Password=fa5t5tat5; 

 

• The Digital Integration.zip available from: 

https://www.apteco.com/portal/software-releases 

 

• Decide where your FERG folders are to be created 

Used to store the .xml and .bat files used when scheduling FERG 

Bulk insert folder must be accessible from SQL Server to use BULK INSERT 

 

• Decide where you want the FastStats Email Response Gatherer to be installed 

This will typically be on the same PC as the FERG folders but can be on any PC 

 

• The SilverPop API Username and Password 

• The SilverPop Mailing Name and List Name 

 

 

https://www.apteco.com/portal/software-releases
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2 Process Summary 

 Architecture 
The following diagrams describe a typical process from FastStats to SilverPop, to the 

customer and back to FastStats. 

Schematic showing campaign scheduling performed in IBM Watson, SilverPop. 

 

1. A broadcast is initialised through the FastStats Web Service using the Email 

Broadcasting Wizard, which inserts a job into the Web Service Control database 

(WS_DB). 

2. The FastStats Service picks this job up, uploads the list to the IBM Watson, SilverPop 

SFTP site and then uses RESTful communication to monitor the upload. 

3. IBM Watson, SilverPop then imports the contents of this list to its contacts database 

and associates them with a message name ready for use in any email campaigns. 

4. A campaign can then be scheduled using the IBM Watson, SilverPop web interface. 

5. IBM Watson, SilverPop sends Messages to all recipients on the list. 

6. IBM Watson, SilverPop records any undelivered messages. 

7. IBM Watson, SilverPop records a response for each interaction with a message (for 

example opens and clicks). 
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8. A scheduled job on the FastStats server initiates the FastStats Email Response 

Gatherer (FERG) which checks the SFTP site for response files. 

9. These responses are then imported into the Response database (RS_DB) ready for 

analysis by your FastStats system. 

Schematic showing scheduling performed in FastStats or PeopleStage. 

 

The key difference in this process is messages are sent from IBM Watson, SilverPop 

automatically, allowing full control of the campaign scheduling from within the Apteco 

Marketing Suite.  

Note: 

For the message to send automatically, you need to create a Contact List and a 

Message in IBM Watson, SilverPop 
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3 Apteco System Configuration 

 Creating the Response Database 
You will need to create a response database to receive your responses from the ESP.   

1. Open the FastStats Configurator. 

Tip: 

Search for Fast in the Start Menu  

 

2. Select Database Management. 

 

3. Select the Database Creation Wizard option and click Start Wizard. 
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4. Enter the name of the Database Server where you wish to store the response 

database, click Test Connection 

 

Note: 

The Database Server name can be found by launching SSMS and finding the SQL 

Instance for your FastStats system, for example TDWIN10B\SQLExpress.  

 

5. Enter a System name (for example Holidays) and your secure password.  
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6. Select the Email Response check box, then click Next. 

 

Note: 

The Response Database may already exist, see the Notes column if it does you do not 

need to complete this process, click X to exit the installer. 

7. Click Next on the Review actions step. 
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8. Click Run Scripts. 

 

9. Click Finish. 
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 Linking the Response Database to the FastStats 
Service 

You need link the response database to the FastStats service. 

1. Open the FastStats Configurator 

2. Select FastStats Services 

 

3. Select the FastStats Service for the system to link to the response database, click 

Properties 
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4. Select the system tab you want to link the response database, select Email 

Broadcasting from the list on the left and then enter the database connection 

string to your response database. 

 

5. Click Test Connection, click OK to close the dialogue box 

 

6. Select Save from the File menu 

Note: 

A restart of the FastStats service is required to pick up the changes to the 

configuration, click Restart in the Managed Services dialogue box. 

General Considerations 

For broadcasts to work correctly you need to ensure that the FastStats server has access 

to the relevant SilverPop server through port 443, see the example URL below; this may 

vary with your account: 

transfer2.silverpop.com 
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 Installing the Email Response Gatherer 
You can find the FastStats Email Response Gatherer installer in the 

DigitalIntegration.zip, extract the zip file to your designated PC where you want the 

email response web gatherer to run.  

Digital Integration.zip available from: 

https://www.apteco.com/portal/software-releases 

Note: 

The FastStats Email Response Gatherer application can run on any PC in your system. 

 Open the EmailResponseGatherer64Setup.msi from the DigitalIntegration\ 

EmailResponseGatherer folder. 

1. Click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.apteco.com/portal/software-releases
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2. Select the check box to accept the terms and click Next 

 

3. Click Change if you wish to install the Email Response Gatherer application in a 

different location then click Next 

 

Note: 

The default directory for this is C:\Program Files\Apteco\FastStats Email Response 

Gatherer x64 but may be different, we recommended that you install this in your 

FastStats application files directory on the FastStats Application Server. 
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4. Click Install to start the installation 

 

5. Once the installation has completed, click Finish 
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 Creating the Response Gatherer Folders 
You will need to create folders to store the files to use with the Response Gatherer; 

these will include the following types of files. 

Table 1 – Files Associated with the Response Gatherer 

Type of file Description 

Batch (.bat)  Contains the information for applications 
like Task Scheduler or command-line 
programs to run the Response Gatherer on a 
schedule 

XML (.xml) Contains the connection and communication 
parameters used to connect to the 
broadcaster 

Text files (.txt) The Response Gatherer will generate two log 
files each time it runs, an Event log with the 
times each event occurred, and a Details log 
with a step by step log of the digital 
response batch process with the broadcaster 

 

You can create the directories in any user-defined location and use your own choice of 

name; you must refer to the directories in the batch file. 

A typical example folder structure 

 

Important: 

The bulk insert directory must be accessible from the SQL server and the user running 

the SQL Server Service must have read permissions to it. 
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 Creating the Configuration File 
You will need to create an XML file containing the configuration settings to use with the 

Email Response Gatherer; the XML file is specified in an argument when you run the 

EmailResponseGatherer.exe 

Note: 

You can use the Response Gatherer with multiple integrations by using an XML and 

matching batch file for each integration. 

1. Browse to the directory where you installed the Email Response Gatherer and open 

the EmailResponseConfig.exe, enter your Connection String and click Test 

2. Select SilverPop from the Broadcaster drop-down list 

3. Enter the Username and Password to use with the SilverPop API 

4. Use Add to add all the required parameters for the Broadcaster 

5. Use the File menu to save the XML file to the batch and XML file folder 

 

Note: 

The Email Response Config application displays a warning message about required 

parameters until you have included them all.  
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Table 2 – EmailResponseConfig Parameters 

Dialogue Item Settings to use 

Connection String The connection string to the response 
database for your system 

Timeout (secs) The timeout (in seconds) for the connection 
and query steps, the default is 1200 seconds 

Bulk insert folder The location to store the results to optimize 
the processing of campaigns that generate 
large volumes of data, SQL Server can BULK 
COLLECT from this location  

PeopleStage Connection String Used for certain broadcasters, to retrieve 
metadata from the PeopleStage database 
Not applicable with SilverPop 

Email Response Config dialogue with ADDITIONAL FIELDS completed 

 

See Appendix B Email Response Gatherer Parameters for a full list of available 

parameters to use with the Email Response Gatherer. 
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  Scheduling the Response Gatherer 
You need to set FERG to run on a scheduled basis, provide it with the broadcaster’s 

communication details (in a .xml configuration file) and the location to output the Log 

files; this example uses Windows Task Scheduler however you can use any similar 

application or create Command Line (.cmd) files manually.  

Creating the Batch Files 

The batch files provide the Response Gatherer with the Log file directory and the name 

of the XML file to use. 

Create or modify the batch file using Notepad++ or similar text editor, see appendix B 

for an example file, save the file to the batch and xml file directory. 

Using Task Scheduler 

Using the Windows Task Scheduler, you can create multiple Tasks to run the Response 

Gatherer on a timed basis. 

1. Open Windows Task Scheduler 

Tip 

Search for Task in the Start Menu 

 

The Windows Task Scheduler opens 

2. Select Create Basic Task 

 

Tip: 

You can create folders to organise your tasks 
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3. Create a Basic Task step 

a. Give your task a Name and Description 

 

4. Task Trigger step 

a. Select the Trigger interval 

 

b. Enter the Start Date and Time or relevant sub-step details 
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5. Action step 

a. Select Start a program and click Next 

 

6. Start a Program Step 

a. Click Browse then navigate to the folder containing your batch files, select 

the file to use and click Open 

b. Optional: Provide the name of the XML configuration file in the Add 

arguments box, click Next  

Note: The XML file is typically included in the batch file. 

 

7. Summary step – Click Finish 
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4 FastStats Broadcasting & Responses 

Notes: 

You must log in as an administrator to perform the following task. 

The Email Broadcasting Wizard is required for FastStats use only. 

 Enable Email Broadcasting 
You must enable the Email Broadcasting wizard plugin. 

1. Open the FastStats Configurator 

2. Select Web Service 

 

3. Click OK on the Web Service Chooser dialogue box 

 

4. Click Client Configuration 
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5. Select the Discoverer client associated with your system and click Edit 

 

6. On the Plugins tab ensure the Apteco.Discoverer.Plugins.EmailBroadcasting check 

box is selected then click OK 
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 Configuration in FastStats 
1. Open Apteco FastStats, select the Users explorer, right-click on the Global node 

then navigate to Modify > Plugin Configurations 

 

2. Expand the Wizard node then clear the Inherit check box for Email Broadcasting 

(User Defined Fields) and then click on the Edit button. 

 

 

 

Clear 
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3. Click Add to add a new template 

 

4. Enter a Name, select the appropriate Resolve Table from the drop-down and select 

SilverPop from the Broadcaster drop-down. 

 

Note: 

Scroll to enter the Known Parameters information, some fields will be entered 

automatically, * indicates a required parameter. 
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Complete the template parameters form with the required settings for your SilverPop 

account. 

Table 3 – Edit Upload Template Known Parameters Settings 

Parameter Reqd. Settings to use 

URL Y https://api[pod].silverpop.com/XMLAPI 
Dated List Format Y yyyyMMdd-HHmmss 
Visibility Y 1 
FTP Username * Y username* (blank by default) 
FTP Password * Y password* (blank by default) 
FTP URL Y transfer[pod].silverpop.com* 
Upload Empty Lists  Selected (default) 
Private Key Path   
Upload Only Contact List 
Folder 

  

Upload And Broadcast 
Contact List Folder 

  

Upload Only List Folder   
Upload And Broadcast List 
Folder 

  

Client ID Y A unique alphanumeric string* 
Client Secret Y A unique alphanumeric string* 
Refresh Token Y A unique alphanumeric string* 

(You will receive this from Watson 
Automation by email) 

List Id Column Name   
Master Table Y The database to use within SilverPop 
Encoding Y Default 

 

Note:  

*These settings will be specific to your SilverPop account. [pod] refers to a unique 

numeric ID for your account 

 

Note:  

You will need to exit out of FastStats and log in again for these changes to take effect. 
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 Checking your configuration 
You can test the configuration by creating a Data Grid and using the email Broadcast 

Wizard; this will send a message to the people in your selection. 

Note:  

You must set up a message in SilverPop before performing this step see Appendix A 

Configuring SilverPop. 

1. Create a Data Grid based on the appropriate selection criteria and drag on the 

variables that you want to pass to SilverPop (one must be an email address) 

 

2. Click the Email Broadcasting icon 

 

The Email Broadcasting Wizard opens 
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3. Choose the SilverPop template from the drop-down list and click Next 

Note: 

The wizard will omit this step if you have only one Upload Template 

 

4. Choose the email field and click Next 

 

5. Review the additional fields that will be sent as part of the list and click Next 
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6. Complete the Email Broadcasting Details form then click Next 

 

Table 4 – EmailResponseGatherer.exe.config Settings 

Option Settings to use 

Username  The username for your SilverPop account 
Password The password for your SilverPop account 
List Name drop-down Click on the List Name retrieve button and select a 

list from the drop-down (this appends any new 
records to the list) or enter a new List Name 

Message Name Click on the Message Name retrieve button and 
select one from the drop-down or leave it blank if 
you only want to upload your list 

A copy of the list will be 
saved to the directory 
below 

Browse to the location where you wish to save a 
copy of the list 

Email Address Enter an Email Address FastStats will use this to 
notify you once the list has been processed and 
then click Next 

7. If you entered a message name, a Broadcast Warning message displays meaning 

this will send a message to your target audience 

Click Yes to commit this action 
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8. Once the list has been uploaded (and if applicable the message delivery has 

been scheduled), the wizard will complete.  Click Finish to close the wizard. 

 

 

Note:  

You will need to exit out of FastStats and log in again for these changes to take effect. 
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 Email Responses Wizard 
When your emails have been sent out you can start analysing the responses from your 

target audience. 

1. Open the Email Responses wizard 

2. Enter the name of the message that you used in the Email Broadcasting wizard 

and click Next 

 

3. As the Email Response Gatherer starts collecting information from SilverPop, 

you will see how customers are interacting with your broadcast. If you want to 

analyse this information further, click on Create a virtual variable from this 

information and then click Next 

 

4. Drag the Email variable that you used in the Email Broadcasting wizard onto 

the drop box and click Next 
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5. Locate the folder where you wish to store the virtual variable and click Next 

 

 

 

6. Enter any notes that will be stored along with the virtual variable and click Next 
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7. Enter a Description for the virtual variable or drag an existing virtual variable 

onto the drop box if you wish to overwrite it. Modify the Security Attributes if 

applicable and then click Next 

 

 

 

 

 

8. Click OK 
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9. Click Finish 
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5 PeopleStage Broadcasting & Responses 

 Defining the Broadcast Channel in PeopleStage 
To use SilverPop with PeopleStage, you must set up a channel that defines the settings 

and parameters and any fields that you always want to send to SilverPop. 

1. Open PeopleStage, select File > Administration > Channel Editor.  Click Add 

Email Channel through the context menu within a folder 

 

2. Enter a name in Channel Name 

 

Note: 

(Optional) Select Yes from the Allow In Transactional Output (you need to be careful 

if you select this option, as it means we can send multiple emails to the same email 

address) 

 

3. Define Output Settings for SilverPop 

Email - SilverPop 
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Table 5 –PeopleStage Output Settings 

Field Settings 

Broadcaster Select SilverPop from the drop-down 
Username Enter your API username 
Password Enter your API password 
Variable Name Select Email Address from the drop-down 
Variable Description Override Enter the description, for example, “Email Address” 

Note: This must correspond to the e-mail field 
within SilverPop 

Upload but don’t broadcast (Optional) – Select this check box to upload the list 
only without initiating a broadcast 

Reply email Address The email address that will receive notifications 
when the channel is used, i.e. list uploaded / 
broadcast. 
Note: This is not the reply email address that will be 
used for the email send. 

Number of Retries The number of times to retry on failure of the 
channel.  It is recommended (for Broadcast 
Channels) to leave this at 0.  The Delivery Agent also 
has a retry value, so setting this to > 0 can result in 
multiple retries and may cause undesirable results 

Response File Key Type The key field to match responses to sends.  Varies 
from broadcaster to broadcaster due to the fields 
they return in the response file.  Should be set to 
Communication Key for SilverPop. 

Message Content Type Only Dynmark has the ability to use PeopleStage 
templates so this will always be Broadcaster 
Template.  This is where the creative comes from. 

 

SilverPop 

oath 
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4. Complete the File Settings 

 

Note: 

The default Encoding is Windows-1252 if you change use the same setting on the 

Parameter Settings tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. The ESP Parameter Settings tab is blank by default, select parameters from the 

drop-down and click Add to complete the form 
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You will be able to get these from SilverPop or contact your Partner or Apteco 

 

Table 6 –PeopleStage Parameter Settings 

Field Settings 

 *These will be specific to your account 
Visibility 1 
FTP URL Transfer[pod].silverpop.com (pod is a unique 

number specific to your account) 
FTP Username Enter your FTP username* 
FTP Password Enter your FTP password* 
FTP Protocol Either sftp, ftp or ftps* 
Master Table The name of the SilverPop database to use 
Client ID A unique alphanumeric string* 
Refresh Token A unique alphanumeric string* 
Encoding UTF8 
Client Secret A unique alphanumeric string* 

See Appendix B for all the available parameters 

 

 

6. Add any additional variables on the Additional Variables tab 
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7. Click Save & Close 

 

 

 

 

 

 

 

 

 Broadcasting in PeopleStage 
You can now test your channel at any Delivery Stage 
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1. You can drag your new SilverPop channel from the Library to your Delivery step 

 

2. You can select from the available messages in SilverPop from the Message 

Name drop-down or use PeopleStage’s functionality to dynamically select a 

message, to use a different language for example. 

 

 

3. Enter your SilverPop List Name 

Selecting the Requires Manual Approval check box gives the option to view a sample 

list before processing 
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Appendix A: SilverPop Configuration 

SilverPop from IBM Watson, SilverPop works on the principle of having a database of 

subscribers, which you can segment into lists.  FastStats or PeopleStage will upload a list 

of subscribers and insert them into the SilverPop database. 

If you wish to automatically broadcast the list to a message either from the Email 

Broadcast wizard or PeopleStage, you need to create a message with a Mailing Name 

within SilverPop. 

1.  Login to your SilverPop account to access the web-based control panel 

 

Note: 

IBM Watson uses Shared or Private folders, you should create your databases and 

content in the Shared area. 

A. Organization Settings and Required Information 
You need the following three items to use in FastStats with Watson: 

Client ID, Client Secret and a Response key. 

The first two are provided when creating an Application in Watson 

Adding an Application 

2. From the Settings menu select Organization Settings 

 

3. From the Application Account Access node click Add Application 
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4. Click in the application name to see the Application Details dialog 

 

Application Details dialogue with the Client ID and Client Secret 

 

The Response key is created when you add account access. 

Add Account Access 

5. Click Add Account Access and select the new application from the list 

 

6. Select the Application from the drop-down and the User Account from the Add 

Account Access form 
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Getting a Response Key 

An email with the Response Key will be sent to the email address associated with the 

selected user. 

B. Creating a Mailing Database 
You need a Database for each mailing list, from the Data menu select Create from the 

database section 

 

The database creation wizard launches. 

From Step 1 - choose the type of database and complete the form: 

• You will most likely choose Double Opt-In or Single Opt-In depending on your 

preferences requirements. 

• Enter a Database or List Name 

• Click Select to choose the Shared area 

• Either Flexible or Restricted will work, Restricted requires a Unique Identifier at 

setup. 

Click Next 
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From Step 2. add the required fields for FastStats 

 

You will need the following fields as a minimum: 

URN - needed to map to the URN in a FastStats system 

Email – (This is added by default in Watson and is set as the Unique Identifier) 

Click Edit Unique Identifiers and set the URN field as the UID, click Save 
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Any other fields such as the following are dependent on your campaign requirements, 

for example: 

• Forename 

• Surname 

• Subject – used to personalize the message 

• Run Number 

• Communication Key -  May be required for PeopleStage 

Click Create to complete the Database/list creation process 

Note: 

The above database name is used as the Master Table entry during the creation of the 

Upload Template (see 4.2 Configuration in FastStats). If the Master Table is not 

specified Watson will create a database automatically. In this way you can still use 

Watson without creating a database. 
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Creating a new Message in SilverPop 

1. From: Content go to Mailing Template 

 

The Mailing Settings & Content dialogue opens 

2. Enter a Mailing Name for the message and complete the rest of the settings as 

appropriate: 

• Subject Line (dynamic content can be used e.g. “Welcome to Summer 

%%First Name%%”, you will need to configure the Contacts first 

• Import Message – To import a message 

 

Add any relevant offers that you want in the message, these can be picked up by 

PeopleStage when clicked by the recipient. 

3. To further Add/Edit HTML or text content use the HTML tab 

4. Once complete, click Save  

Note: 

You should test your message to ensure there are no problems with the email 

message. 
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Appendix B: API Parameters 

Table 9 – Email Response Gatherer Parameters 

Parameter Req. Default/System Specific* Description 

URL Y https://api[pod].silverpop.com/

XMLAPI* 

The web service on the server that hosts 

your SilverPop account 

ApiProtocol Y https* The communication protocol used with 

SilverPop, either http or https 

FTPURL Y transfer[pod].silverpop.com* The ftp location where your SilverPop 

responses are generated 

TYPECOLUMNNAME Y Typically, this will be:  

Event Type* 

This should refer to the column in the 

Silverpop extract file that holds the 

message type, i.e. sent, open, click 

through, etc.  The value will get inserted 

into the MessageType field in the 

Reponse table.   

MESSAGENAMECOLUMNNAME Y Mailing Id  

CLICKURLCOLUMNNAME Y URL This should refer to the column in the 

Silverpop extract file that holds the URL 

that was clicked.  The value will get 

inserted into the ClickUrl field in the 

Response table. 

CLICKDATECOLUMNNAME Y Event Timestamp This should refer to the column in the 

Silverpop extract file that holds the date 

that the Url was clicked.  The value will 

get inserted into the ClickDate field in 

the Response table. 

EVENTTRIGGEREDDATECOLUM

NNAME 

Y Event Timestamp This should refer to the column in the 

Silverpop extract file that holds the date 

that the event was produced.  The value 

will get inserted into the 

EventTriggeredDate field in the Reponse 

table. 

 

The following data is inserted into the FastStats Email Response Table 
 Required Response Table field SilverPop extract file column 
EMAILCOLUMNNAME N Email Email address 
URNCOLUMNNAME N Urn FastStats Urn. Only available if it has 

been previously uploaded from 
FastStats 

COMMUNICATIONKEYCOLUMNNAME N CommunicationKey FastStats Communication Key.  Only 
be available if it has been previously 
uploaded from FastStats 

RUNCOLUMNNAME N  Reserved for future use 
DELIVERYDATECOLUMNNAME N DeliveryDate Delivery date 

 

 

Note:  

*These settings are specific to each SilverPop account. 
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Continued 

Additional Configuration Required Default Description 
DATEFORMAT N  Date format used e.g. dd.MM.yyyy 

HH:mm 
DATEOFFSET N 0 Value in hours to offset any date 

values received.  This allows you to 
write responses in your current time 
zone.  

PEMPRIVATEKEY N  If secure ftp is used above and 
requires a private key, this should 
refer to the path and filename of 
that key 

FILEPATTERN N  Allows you to filter your responses 
to specific types when reading files 
from the ftp site 

MAXRETRIES N 1000 The number of times the Email 
Response Gatherer will check to see 
if the extract file exists on the ftp 
site 

READACCESSRETRIES N 300 The number of times the Email 
Response Gatherer will check to see 
if the extract file is readable on the 
ftp site.   

DELIMITER N Tab Type of delimiter used in the extract 
file, options include: 

• COMMA (,) 
• DOUBLEQUOTE (") 
• NULL. 
• SEMI (;) 
• SPACE ( ) 
• SINGLEQUOTE (') 
• TAB 

ENCLOSER N None Type of enclose used in the extract 
file 

TreatTypeAsAdditionalField N false Setting this to true will force the 
raw response type to be written to 
the ReponseDetails table before 
any conversion is carried out 

TreatMessageNameAsAdditionalField N false Setting this to true will force the 
raw message name to be written to 
the ResponseDetails table before 
any conversion is carried out 

LookupBroadcastIdsOnTheFly N false False will force the Email Response 
Gatherer to download a full list of 
Broadcast Ids from all the previous 
broadcasts in the response 
database.  This can then be used to 
quickly match responses to 
broadcasts.  If set to true, the 
Broadcast Ids will be fetched and 
cached as and when required 

OnlyProcessRecordsWithBroadcastId N false Setting this to true will force the 
Email Response Gatherer to only 
download responses to messages 
that have originated from FastStats.  
The default option is false; all 
responses will be downloaded. 
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Table 10 – Email Broadcasting Parameters 

Parameter Required 

Y/N 

Default Description 

URL Y https://api[pod].silve

rpop.com/XMLAPI 

The location for the FastStats Service to 

use 

DatedListFormat Y yyyMMdd-HHmmss The date format string for the date and 

time stamp if created 

Visibility Y  Choose your visibility  

0 - Private 

1 - Shared 

ApiProtocol N https  

FTPUsername Y  The username for the login to the ftp site 

specified in FTPURL. 

FTPPassword Y  The password for the login to the ftp site 

specified in FTPURL 

FTPURL Y transfer[pod].silverp

op.com* 

The ftp location where your upload will 

be generated 

FTPProtocol Y sftp The type of ftp protocol you will be 
using to upload your list. 

PRIVATEKEYPATH N  If secure ftp is used above and requires a 
private key, this should refer to the path 
and filename of that key 

Upload Only Contact List Folder N   
Upload And Broadcast Contact List 
Folder 

  Upload and broadcast contact list folder 

Upload Only List Folder    
Upload And Broadcast List Folder    
Client ID Y  A unique alphanumeric string* 
Client Secret Y  A unique alphanumeric string* 
Refresh Token Y  A unique alphanumeric string* 
List Id Column Name    
Master Table Y   
Encoding N UTF8 Enter the encoding of the incoming file 
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Appendix C:Example Batch File 

Example batch file to use with FERG and scheduling 

@echo off 

REM**************************************************************************** 

REM File Name: SilverPopBatchFile.bat  

REM Date: 30/01/2018 

REM ToDo: 

REM Define the drive and folders to output the log files 

REM Set FERG to define the location of the EmailResponseGatherer64.exe 

REM Set LOGFILE to the folder where the event logs are stored 

REM Set LOGFILEDETAILS to the folder where detail logs are stored 

REM Define the XML configuration file to use 

REM *************************************************************************** 

D: 

cd D:\FastStats\FERG 

cls 

SET FERG="%ProgramFiles%\Apteco\FastStats Email Response Gatherer x64\EmailResponseGatherer64.exe" 

SET LOGFILE="Logs\SilverPop.txt" 

SET LOGFILEDETAILS="Logs\SilverPop_Details.txt" 

echo. >> %LOGFILE% 

echo. >> %LOGFILEDETAILS% 

echo %date% %time% - Starting FastStats SilverPop Response Download >> %LOGFILE% 

echo %date% %time% - Starting FastStats SilverPop Response Download >> %LOGFILEDETAILS% 

echo. >> %LOGFILE% 

>> %LOGFILEDETAILS% 

echo. 

%FERG% SilverPop.xml >> %LOGFILEDETAILS% 

 

IF ERRORLEVEL 9003 goto FailedException 

IF ERRORLEVEL 9002 goto FailedLogout 

IF ERRORLEVEL 9001 goto FailedDownload 

IF ERRORLEVEL 9000 goto FailedLogin 

 

:OK 
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echo %date% %time% - FastStats Gathered SilverPop Responses OK >> %LOGFILE% 

goto Complete 

 

:FailedLogin 

echo %date% %time% - FastStats Gatherer Failed - Login Failed to SilverPop >> %LOGFILE% 

goto Complete 

 

:FailedDownload 

echo %date% %time% - FastStats Gatherer Failed - Downloading from SilverPop >> %LOGFILE% 

goto Complete 

 

:FailedLogout 

echo %date% %time% - FastStats Gatherer Failed - Logging out of SilverPop >> %LOGFILE% 

goto Complete 

 

:FailedException 

echo %date% %time% - FastStats Gatherer Failed - SilverPop API Exception >> %LOGFILE% 

goto Complete 

 

:Complete 

echo %date% %time% - Completed FastStats SilverPop Response Download >> %LOGFILE% 

End of example text 

To see how to use the batch file see section 3.4 Scheduling the Response Gatherer 
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Appendix D:Troubleshooting 

The following are some common problems that may occur, and procedures for 

resolving them. 

Errors relating to configuring and using FERG 

These errors can occur due to missing files 

Description: Error received when running FERG using a batch file 

Error: Could not read email response configuration file: Could not 
find file 'D:\FastStats\FERG\ SilverPop.xml'. 

SilverPop.xml refers to the filename referenced in this section of the batch file: 

%FERG% SilverPop.xml >> %LOGFILEDETAILS% 

In the location: 

“cd D:\FastStats\FERG” in the batch file  

Solution: Ensure the file exists or change the filename in the batch file to match. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 





For customer service and technical support visit: 

www.apteco.com/support 

T: +44 (0)1926 407 595 (Support Desk) 

Note: If you have purchased the Apteco Marketing Suite™ via one of our 
partners then they are your first line of support. 

Apteco GmbH 

Schaumainkai 87
60596 Frankfurt am Main 
Germany 
T: +49 (0) 69 25 66 97 0 – 0 
support@apteco.de 
www.apteco.de 

Apteco Australia Pty Ltd 
Level 2 
99 Macquarie Street 
Sydney NSW 2000 
Australia 
T: +61 (0) 2 8355 2524 

www.apteco.com.au 
Apteco Benelux 

Stationsplein 45, Unit 4.004 
3013 AK, Rotterdam 
The Netherlands 
T:  +31 (0) 10 80 80 875 
Email: support@apteco.nl 
www.apteco.nl 

Head Office 
Apteco UK 

Tink-a-Tank House 
21 Jury Street 
Warwick 
CV34 4EH, UK 

T:  +44 (0) 1926 407565 
E:  support@apteco.com 
W: www.apteco.com 

© 2020 Apteco Ltd. All rights reserved. 

This publication is for informational purposes only. While 
every effort has been made to ensure accuracy, this 
publication shall not be read to include any warranty or 
guarantee, express or implied, including about the products 
or services described or their use or applicability.  

Apteco Ltd. reserves the right to modify or improve the 
designs or specifications of its solutions at any time without 
notice. 

http://www.apteco.com/support
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